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Today's Training Agenda

* |ntroduction to Microsoft Office365.

= Accessing Email via Outlook Desktop Application and Web

based.
=  Microsoft TEAMs.
= One Drive For Business.
= SharePoint Online.
= Document Management System
» SharePoint Online Co-Authoring

°'. .E UNIQ Solutions
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Office 365 Suite includes
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Accessing Emails

» Outlook 2016 Desktop
Application.

» Outlook Web Access on any
modern web-browser (IE,
Firefox, Safari, Chrome)

 Any mobile-phone supporting
ActiveSync (including iPhone,
most Android phones and
Windows Smartphones)

.. * UNIQ Solutions
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N I|ﬂ21 https://ped51030.outlook.com/owa/?ex: O ~ @ G X ” ﬂﬂ Carlos Grilo - Outlook Web ... ‘ ‘

] Office 365

® new mail

4 Carlos Grilo
4 Inbox 1
Far Followup
Tech Impact
Webinars 3
Drafts
Sent Iltems

4 Deleted Items

Junk Emai

Motes

TASKS

Conversation His

In-Place Archive - Carl

search mail and people
all unread tome flagged
INZOX

THREE WEEKS AGO

v Karen Berg 0
I'd like to share my calendar with yc

CONVERSATIONS BY

Outlook Calendar People MNewsfeed SkyDrive Sites e Car|

jo

DATE «

x>
6/7/2013

Karen Berg {(karenb@techimpactdemao.on...

LAST MONTH

Jeff Hay
The Webinar Today
Break a leg! -Jeff Hay

Jeff Hay

I'd like to share my calendar with yc

5/23f2013

5/23/2013

leff Hay (jeffh @techimpactdemo.onmicr...

Welcome
The "Welcome™ site has a new mailt
MNow you can sen

OLDER

Karen Berg
Featured Services for Newsletter

5/3/2013

d mail to SMO-Welcom...

=

4/29/2013

Hey Carlos, Here is the revised list of serv...

no-reply@sharepointonlir
Karen Berg mentioned yoJ inacom

Karen Berg: @Carlos Grilo how was the...

4/292013

»»»»»»

I'd like to share my calendar with you

& REPLY

Karen Berg
. Fri 6/7/2013 11:51 AM

To: Carlos Grilo;

€6 REPLY ALL

=+ ADD CALENDAR  [£] SHARE MY CALENDAR BACK

Karen Berg (karenb@techimpactdemo.cnmicrosoft.com) has in
or her Microsoft Exchange Calendar.

For instructions on how to view shared folders an Exchange, se
article:

http://go.microsoft.com/fwlink/?Linkld=57561

**********




Create appointments,

tasks, contacts & more

MICROSOFT OUTLOOK 2016

Mews Drip - Stephanie.Petrashko@carefreeit.ca - Outlook

Flag items &

add reminders

HOME SEMND / RECEIVE FOLDER. VIEW
El | [xignore x E’_\j rE’ -\ﬁ & 52 Mesting Mews Drip £3 To Manager ¥ @ \E—I E’_“j n Search People
- = s —

N N - % Clean Up ~ < > = Team Email v Done . Rlljl D-)N pecian Unread/ C III R EE Address Book
= ew = - ove Rules OneMote ign Unrea ategorize Follow ) )

Email ftems- o Junk~ . € Reply 8 Delete  # Create New = Policy~ Read - Up- Y Filter Emai Filter

Mew Delete CUSiomlze your Quick Steps - ove Tags Find
B [ - e = i Pl [

4 Favorites OU"OOk View £ | current Folder -] — | 4 Movember 2014  »
Inbox ByDate *  Mewest + =] Mq nqge rules SU MO TU WE TH FR SA
Sent Items Mail Delivery System il Stephanie. Petrashko@Carefree 3 37 38 29 30 3 1
Deleted tems 76 Mail delivery failed 02/25/2014 October News Bytes 7 3 5 6 7 8

This message was created automatically by mail To Stephanie Petrashka 9 10 11 12 13 14 15

[—

Box Mail Delivery System 1} E—— 16 17 18 19 20 21 22
Chent e-mails Mail delivery failed 02/25/2014 quendqr & 23 24 25 26 27 28 29
Client Feedback This message was created automatically by mail . W 01 2 3 4 5 &
Flagged Stephanie Petrashko GPP°|n|'men|'s T
Gary February News Bytes 02/25/2014 |:| Ca refreelT " omarrow

Carefreell News Bytes 9:00 AM Doctor's appointment
Jane Doctor's office
Job applications DoNotReply@Carefreell.ca B t
John Marketing Manager requests completed 02/25/2014 y es Thursday
e Markatipg ianagarhas comp I October, 2014 10:00 AM Meeting - Chicopee Ski Cl...

Meeting room
. —

Nadia Inbox subfolders
Mews Drip [2/25/2014

Carefreell News Bytes ] H Arrange by: Flag: Due Date | Later -
o What's New In Windows | |

. — Ty rtask
Podio Stephanie Petrashko YpE A e
p February Mews Bytes 02/25/2014 Cur services >
oonam )
S Carefreell News Bytes Microsoft recentl‘{ Checking in I..
e Stephanie Petrashko across all Window Waterloo Minor Soccer >
errals
el et test 02/25/2014 m—g'"fart“h“"% to Message from KMBT 363 >
ocial media e

Carefreell News Bytes October newslettar IP

TruMethods - Ceohar Detrch »
2E& more about stephanie Fetrashko. i

WebPro News DoMotReply@CarefreelT.ca - i ] |:| ‘ "~ Praposal Outline |
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Outlook 2016

Set up your account

You can use Outlook 2016 as soon as you enter your account info. On the ribbon,
click File > Info and then click the Add Account butten. Sign inwith your pre-
ferred email address, or use the information provided by your company or school.

TioEThe pa twErD paur ITier- T Sn<e prelsr hes ghEn L.

Create new items

In Mail view, on the Home tab, click New Email to compose a new email message,
or click New Items and choose the type of item you want to create.

|T| 5% Ignore x

7 Clean Up~
MNew Delete
|tems - 3@ J unk-‘
E-mail Message
Appointment
Meeting
Contact

Task

s [ EED

E-mail Message Using ¥
Maore [tems »

L% Skype Meeting

) Office

Organize mail with rules

Ifyou regularly receive large amounts of email from different sources, consider
setting up rules that automatically file messages into mail folders you've created.
Start by clicking the Organize tab, and then click Rules > Create Rule.

Create Rule =

When | get e-mzil with all of the selected conditions
] Erom Malcrie Potvin
T]5ubject contains | Team meeting agenca

Isenliu |me only
Du Lhe Tolluwiny
A Displayin the New Item Alertwindow

__|Play a calartad sound: b |m Browse...

" IMove the item to folcer: Select Folder..,

Cancel Advanced Cptions...

Switch between views

There's much more to Outlook than email. AL the bottom of the app window, you
can easily switch between the Mail, Calendar, People, Tasks, Notes, and Folders
views to manage all aspects of your busy life.

Commands on the ribbon will switch to match the view you've selected, as will the
information shown on the Outlook status bar at the bottom of the app window.

Navigation Options...
Notes

Eclders

[@] Shortcuts
= e f13 E e

ltems: 6  Unread: & = Reminders: 3



Outlook 2016

There's more to Qutlook than email

Switch to the other views to manage all aspects of your busy life.

Easy to use Calendartools and commands

In Calendar view the ribbon displays everything you
need to manage every day, week manth, and year.

Microsoft

1M1z 13 #1516 T
1819 20 N 22 E M
?5 PR T PR P3 W M

Switch your point of view

Click to see how busy your
days, weeks, and manths are.

Celendar - Chatlock

Navigate yourschedule
While looking at the current

Navembar 2015
5U MO TU WL TH T3 5A 4
1z 5 ¢ 5 & T
3 ® 12 11 12 1= 4
LT LI P I - (A |
L2 4 M 2 ds 4
M, 1z 34 T
5
57 2 2101 2 E
B
X
4 My Calendars =
2
Lalcndar g
&
=
g
= om s [ e
ezmss 0

5 day, week, or month, click the
Back aor Forward arrows to
switch the current view.

Look back — orway ahead

Need to look up a past event 21
arwant ta schedule something

in the distant future? Click the

small arrows to the left and

right of the current month to

skip to the day you want. 8

Send f Feczive  Talder wan 1o co.
‘ o E — —|
E“ T g T j rn ; i
El = & E E El E El | e =1 it [k acdress Boak
Mew Mew Mew lodmoy Mo/ Wark  Week Montk Scheduc Upen  Caendor E mal skare Pubbsn Caendor
Aspenimett Meeting feris - Cays View N Calenda - Groups- | Calendar Caender Onlne- Permissicns
New oo E Arrange L Wanage Calencsrs Share
- ol 2075 F
® 4 October 2015
AU MO IV WE IH F2 NG
7 2% 230 1z 3 MOMN_AY [UESDARY WECHESDAY
05T 3 s 5o 28 29 20

Look someone up before scheduling

Type a name and search to verify someane's
contact info before settingup a meeting.

Tod.
BE*F/TA'F

THURSAY

=

;EI"F",,'%TF Search Calencar (Cirl=D)

DAY 58 | UHDAY
2 3

. a 10
16 17
23 24
30 M

2]

] Office

Sunshine required?

Glance at the weather forecast to make sure
your meeting or event waon't be rained out.

Search your calendar

Start typing in the Search box
ta instantly find meetings and
appointments.

TRt &ppn nimen

Create new items in place
Right-click anywhere to create
a new meeting, appointment
ar other event.




Outlook 2016 () Office

Set your preferences Get help with Outlook

Something networking quite as expected? It's easy to change and customize Type a keyword or phrase into the Tell me what you want to do box on the ribbon
to find the Outlock features and commands that you're looking for, read our online

options at any time. Click File > Options, and then setup Outlook 2016 the
way you want. Help content, or perform a Smart Lookup on the Web for more insights.

Uik upons

W osort mess.agez.l

.
Gz ‘ad moraral estions zrwerkg with Uibezk

Bai St
Tl Reverse Sort

lenzar Uzer Interface cptona
Show as Conversations

sl sl Sl gl o S
Peranalire your copy of Micrands (e El Arrangement Options »
2] Show Al Folders Ato Z
theze values regarcless of sigrin o Pice.
P PRS- X Clean Up »
S
- e Get Help on "sort messages”
E ke Lutiook tre defaut 293 bactr, arel Lalsrcar Nietanl By e
: SO SmartLockup on "sort messages”

Get other Quick Start Guides Send us your feedback

Love Outlook 20167 Got an idea for improvement? Click File » Feedback to

Outlock 2016 is just one of the newly designed apps in the new Office 2016. Visit
http://alka.ms/office-2016-guides to download our free Quick Start Guides for open the Windows Feedback app, from where you can send kudos, gripes,
the other new versions of your favorite Office apps. and ideas directly to the Outlook development team.
If you have any feedback about cur guides, please submit your comments at the
bottom of the download page. Thank you! Welcome!

e o e b B ik v o1 s b
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Office integration

Being able to communicate with people from any

of the Office apps saves time and makes -
for more efficient employees o /K Chan

rom @ Atk Chan

Who's Who + (Get more apps

ENRICHES OFFICE EXPERIENCE
Hi David,
Following up on the team meeting today. You can find the meeting reports

(attendees and documents) in this OneNote.
If you like to see the recording of the meeting check the team’s SharePoint.

SEAMLESS INTEGRATION - ONENOTE, SHAREPOINT, OUTLOOK Please get back to me f you have any questions.

Aik

Ailk Chan | Preduct Marketing Manager

PRESENCE ACROSS THE OFFICE SUITE

@ SharePoint Word Eﬂ OneNote
@ PowerPoint Excel ﬂf] Outlook

INTEGRATION WITH OFFICE ACROSS PLATFORMS

i [=] - ‘I

MOBILE DESKTOP MAC SURFACE HUB




Meet Microsoft Teams
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Microsoft TEAMs- Chat-based workspace

VO

Chat for today’s
teams

Communicate in the moment and

keep everyone in the know

.3 UNIQ Solutions

A hub for
teamwork

Give your team quick access to
information they need right in

Office 365

N

Customizable for
each team

Tailor your workspace to include
content and capabilities your team

needs every day.

N
(=]

Security teams
trust

Get the enterprise-level security
and compliance features you

expect from Office 365.



Chat for today's teams

Microsoft Teams

» People can see content and chat e
history anytime S L e

The Most Important Tech Jobs Of The Fuy
For engineers, there is a lot of opportunity tg
coming years. New advances in technology

Customer Accounts
Development

q Marketing Contoso.com

Social Media (2]
Iove this article! We've got a bright future
> Reply

= Team chats and activities are visible . , —

M -
h Designers . T
to t e e I Itl re tea I I I G" Any update on the bug #456892 that | filed yesterday? I would love to ¢
General
@ ecily C. 11:00 am "
Fourth Coffee - n
5 ‘ @ e © http://www.conto
- +

i | don't know what s causing this just yet. | saw some abnormali <o.com/3054433/the-most-in
Ganera solutions that didn't work. 'm going to chat with Jakob to see | 50.Com e bl f
ant-tech-jobs-of-the-future

®

CONVERSATION

Fun stuff

= Use private chats for small group o —

Just sending some kudos to the team! The leadership team reviewed th)
with the progress. Only a few more weeks until release so let's stay focu future

L]
nver Ion
5 Babek, thanks for passing along the good news! Just wait until

y . Daphne K. 11:05 am
“6 Any update on the bug #456892 that |
Start a new conversation filed yesterday? | would love to get
o=} & AddTeam that resolved before the next update.

A COBB S

= Mobile access on Android, iOS and |

° Miguel S. 11:02 am
W I n d O W S P h O n e | don't know what is causing this just
yet. | saw some abnormalities in
logs and and tried a few soluti
didn’t work. I'm going to chat wi
Jakob to see what other informat

4 more channels




A hub for teamwork

» Chat, content, people, and tools live in a
team workspace

» Voice and video meetings right within
Teams

= Built-in access to SharePoint, OneNote
and Planner

= Work with Office and other documents
right in the app

:' UNIQ Solutions

Microsoft Teams

D

Search

Northwind Traders

General

Customer Accounts

Development
Marketin

G g
Social Media
Website

32 more channels

Designers

O

General

g Fourth Coffee

General

Fun stuff
Marketing
Weekly Specials

4 more channels

Add Team

“

Northwind Traders > Development #

Conversation

Files

@

Wiki  Planner +

Cecily De Crum

This is the latest budget and campaign proposal. We need to get this approved by EOD, so please send your feedback ASAP.

ﬂg 160724-WinterCampaignBudget ﬂg 160724-CampaignProposal

O Reply

Daphne Knowles
Can someone please point me to the latest FY2017 strategy presentation? | need to start polishing the template.
Kadji and Jakob replied

G@  MiguelSiva 11:16 am
‘eo There's still quite a bit of content missing from this deck. You can definitely start working on the template
but we'll still be adding new slides. We also need help improving the charts if you have time!

Meeting Review 1058

O¢ Join

dera

Daniela N 3
'85 Setting up some time to review the marketing plan.

@. Miguel, Corey, I'l try to make this but | need to rearrange some of my other meetings

O Reply
Start a new conversation

A ¢ O BB




Customizable for each team

= Create different channels for work
streams and topics

= Add tabs to frequently used files and
cloud services

= Get updates from the apps your team
uses every day

= Customize notifications so you don't
miss important info

» Build integrations with developer

preview APIs




Office 365: Supporting the unique workstyle of every group

Chat-based Mail & Voice, Video Sites & Content Enterprise
Workspace Calendar & Meetings Management Social
Teams Outlook Skype SharePoint and Yammer
OneDrive for
Business
| . |
Office 365 Groups
Complete Collaboration Solution Integrated Experiences Security and Compliance
Office 365 addresses the breadth of Office 365 Groups and Graph enable Office 365 provides the security,
collaboration needs across organization integrated experiences that facilitate compliance and rTl1anageab|I|ty
effective collaboration required in today’s workplace

% UNIQ Solutions

o ce%@
L I



OneDrive as an ecosystem

OneDrive for Business, comes bundled with your Office365 subscription.
The Office 365 collaboration offers rich integration across products.

& OneDrive

2 &

Pl

for Business

B B B Y: B



One Drive for Business ?

Personal collaboration
space for business

« Each user gets 1 TB of space
 Sync files across all your devices
« Easily find all your files

 Share your files with both internal and external
users

9 |
G
F
o e
—
Ed s

» Collaborate in real time using Office Online

« Automatic versioning of documents
« Multi-factor authentication
* Mobile access from IPad, IPhone, Android and

& OneDrive Windows Phone

PIEs for Business

S, UNIQ Solutions



Intelligence

Discover what's trending around you.
You only see documents that you have access to.

Learn more about what pecple can see in Discover,

+ Discover relevant items
n Loyalty Program
. Back to School
- Your HR Resources
- International Sales -
o a o v] [
. Office 365/SharePaint 20.,

Resources

Loyalty Program at Cont.. Explaining Contoso Cloth..  Contoso Clothing Customer Feedbac
New Products Poglar Poplar A ol by

New Products

Marketing Documents

@ T <}

Sweatshirt 2017

Loyalty App Promc
fied by A

Report of Research & De.
Multy fied

Loyalty Program Incoming Reports

Get the OneDrive apps —

Return to classic

What files appear here?

* + New T Upload <3 sync

iments

Market Segment Performance pdf - My

Cantoso Fashion Reports Q3 Earnings-RWONG-CARB. ..

sustainable construction.pdf - Green Furniture

O Q3 Salesand Marketing Expense Report Audit.pptx

0" Trey Research Sales Info.pptx with me

@ November December Ad Propasals.pptx ..

/2 Search Everything

mfl Prototypes

GreenDesign

Back to School g 918 Meeting on XT7000 Notes.docx

ufl Sports Line

New Products

@ All New Product Farms.xlsx

Architects psd
Marketing Documents
Contoso Active Fiscal Year Preliminary Budget Plan.pdf
International Sales
Contoso Fashion Financial Assessment - Marketing .pdf
Contoso Fashion Reports Q3 Earnings pdf
Contoso Fashion Reports Q3 Earnings-RWONG-CARBON.pdf
Elevation_Building.psd

Elevation_Ground Floor.psd

Floor Plan_2nd Floor.ai

IE5A4743.CR2
Get the OneDrive apps IE5A4818.ai
Return to classic OneDrive

IE5A4837.ai

Modified
Yesterday at 11:42 AM
June 1
September 15
September 14
September 15
September 15
September 13
September 15
September 19
September 15
October 27
Octaber 25
September 15
September 20
September 20
September 20
September 16
September 19

September 19

Modified By

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

Omar Shahine

File Size

333K8

193 KB

370 MB

763 KB

89.5K8

580 KB

557 KB

280 K8

460 KB

636 KB

243 MB

1.10 MB

1.20 MB

1= Sort

haring
& Only you

A& Shared

A Shared

A gill Baer and 2 more
# Everyone and 4 more
A Omar Shahine and 4 m
A CJ Tan and 6 more

A Shared

& Only you

A Gmar Shahine and 1 m
A Shared

A Shared
B Only you
B Only you
B Only you
6 onlyyou
& Only you
& Only you
a

Only you

2 UNIQ Solutions




Productivity

@3 PowerPoin @ | Holy Frankin Nortiwind presentation S oy Fankin 7

ALE HOME  INSERT  DESIGN  TRANSTIONS  ANIMATIONS  VIEW  Tel ant to & ¢ OPENIN POWERPOINT [ Gorth Fort is aiso editing = Y&

A | Eltaoun

Paste New

{2 Duplicate Siide
Side A

Hide Slide

Undo Gipboarg

Katie Jordan -

P Find -

A SHARED Calibri (Body) = 11~ A A” Aa- E-i=-te- ] nasbeeoe] [\ B assseene AG Bl AaBbCcl AaBbCcDd AaBbCcDd AaBbCcDd |

F 28 Replace
F'aflE < Format painter B 1 U v abe X, X A-W.A- = - AL Figures | 1Nommal | TOCHead NoSpacing Heading1 Heading2 Heading3 Heading4 Heading5 Heading6 < [% Select~
- A STRONG Clipboard 3 Font Paragraph g Styles »  Editing -~
Share T
Invite people
B
Can edit ~

Include a message (optio

Executive summary

Katie Jordan| J
Automatically share changes: | Always ~

he current consumer electronics market is experiencing unprecedented change—and with that
changes comes great opportunity. Together, Litware and Contoso are ideally poised to take a Kanayiescan
market leadership position and deliver quality, consistency, and innovation to their customers, Editing i realtima

Garth Fort
Increasingly, peop|piirsritfarsspiegheir devices in hand. They are always on and always connected, so Il‘ s Editing in real tme
they require more ’rom these devices—more power, more speed, more seamless integration. The E E:,l"; counts
industry challenge remains clear: Understand your customers, anticipate their future requirements, and
deliver above their expectations.

lusive Partnel

That's why a Litware-Contoso partnership makes sense. No one in the consumer electronics market has
a better understanding than Contoso of its long history of exciting innovation, turbulent disruption, and

remarkable growth. And no one in the mapigspengistantly navigates through these changes and
empowers its partners like Contoso. What

9.8 . Why Contoso?
e UNIQ Solutions




Team collaboration

Documents

OneDrive S onel
Home view
Search Gotosite 2 Search - - » Contoss » Loyalty Program - Documents L) +
2 z ~ O N sate modified
g - Loyalty Program “ s Quick access
¥ s ” e Deckiop Jubian
L S - — A Dremioada Product Overviews
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Modern sharing
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[NEENTHN Inset  Options  Format Text

Please review the

& Marketing Report -

Calibri (Body) -
Paste B I U . A -
- ¥ Format Painter - =
Clipboard Basic Text
Ta. | KatieJordan
Ce.
Send
Subject  Please review the Sales & Marketing Report

UNIQ Solutions
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Book  Names
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[ﬂj i P [* Follow Up ~

Attach| Attach Signatwre | High Importance

R fem- - ¥ Low Importance
Recent Items -
| Screenshot (11)
C:\Users\odspd\Pictures\Screenshots\
| OWA-Attached file menu
: C\Users\odspd\Pictures\Screenshots\
| OWA-Upload File from PC
C\Users\odsp\Pictures\Screenshats\
- Browse Web Locations v

Browse This PC...

Office
Add-ins

Add-ins

OneDrive - Contoso
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Paste

Send
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" . : 2] &%
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» Format Painter A fook  Names
Clipboard Basic Text MNames
To. | |fKatieJordan
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Sharing and Collaborating...
* Documents are private until shared, except for the “Shared with
Everyone” Folder.

* You can share any file or folder by using “Share” and selecting
people to invite.

* Sharing can be with both internal and external users.

OneDrive @ MaxOffice OneDrive - Contoso

Documents Documents

Welcome to OneDrive @ MaxOffice, the place to store, sync, and share your work. Documents are private until shared. @ new 4 U p|gad - SYHC & ma nage O share

(¥ new document or drag files here v U Name Sharing Modified By
SrSON: a8 arrow
Al ees Find a file ol Personal July 09 Alex Darrow
Shared with Everyone «ee  July 09 & Alex Darrow
w D Mame
@¢ Asia Q3 Marketing Overview Beta we  July 09 & Alex Darrow
Shared with Everyone «s  October 31, 2013 &8 Demo
coe g5 Billing Statement 3 «: 3hoursago @ Alex Darrow
@ 00. O
02.2°% ¢ ® s - . .
0.:”.;..;: U NlQ Solutions @5 Marketing Slogan Suggestions Nov1 e July 09 o Alex Darrow
0o
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SHAREPOINT HOME IN OFFICE 365

2 sharepoint.com

Office 365 SharePoint

International Sales @

IT Web Field Marketing Guide Operations

Quickly get to the sites

you're following and the |

sites you visited

recently. ©) oo = @ i
e Discover what the people
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nformation Tec| Worklng on reCently
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SharePoint Co-Authoring

In Office 365, you can coauthor documents in Word, PowerPoint, and OneNote or a collection of
documents with others simultaneously.

For Word and PowerPoint, enable both major and minor version tracking in the document library
before you start coauthoring.

For OneNote notebooks, you should only enable major versions.

If you use the Excel Web App , you can make real-time co-authoring with others in Excel.
Don’'t turn Check Out ON.

Versions are managed automatically

Documents are saved automatically (if document is in synced location)

Multiple people can edit at once.

Real time conversations though chat.

Real time changes visibility by each user.



Cloud Productivity and Collaboration

@ SharePointl ] Office 365

Sites & Content
Management

S X

Intelligently discover, share, and collaborate on
content from anywhere and on any device



REINVENTING PRODUCTIVITY
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Sites & Content

OneDirive
SharePoint

Delve

Intelligently discover, share, and collaborate on
content from anywhere & on any device



Modern Collaboration

Office 365 Sites

E Sales & Marketing

Engineering

HOME COMMUNITIES DEPARTMENTS - EMPLOYEE

Welcome to the Sales and Marketing site. You will find information on domestic and international sales as well as the latest marketing initiatives.

Finance

Featured Expansion

Legal

Operations

Research and Development
Sales and Marketing

Domestic Sales

CONTOSO ELECTRONICS
DENVER EXPANSION

Industry Trends

International Sales

Marketing Blog

eting Campaigns
eting Documents
eting Topics 4 SUDE1OFE P
Products
Top-Rated Documents

1 upload Cp Share

Name
2012 Pricing Guidelines

¥ XT1000 Product Overview aes
Site Contents
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@5 Europe Q2 Sales wee

B ListofW***ﬂ"Z

05 Midwest Region Q2 Sales o

B Q4 Marketing Analysis
@Z Sales Invoice - Domestic .
S| sales Invoice Asia Q3

Drag files here to upload

1-10 | »

XT2000 Status List

i/ Status Indicators display important measures for your organization and
show how your organization is performing with respect to your goals.
Open the tool pane to configure this Web Part.

. - X
2012 Pricing Guidelines.docx
CONTOSO
o
2012 PRICING
GUIDELINES
INDEX FOR SA AND MARKETING
TEAM
i Sales and Marketing Announcements
W Peeiors - = (® new announcement or edit this list
Changed by Sara Davis on 6/4/2015 7:47 PM v Title
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22 more
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Office Online

Office 365
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International Sales
Marketing Blog
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eting Documents

eting Topics
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ine Management

ct Falcon

1alispin Toys

Site Contents

HOME COMMUNITIES DEPARTMENTS - EMPLOYEE

Welcome to the Sales and Marketing site. You will find information on domestic and international sales as well as the latest marketing initiatives.

Featured Expansion XT2000 Status List

[E] show Only Problems

Create a new file x i/ status Indicators display important measures for your organization and
show how your organization is performing with respect to your goals.
CONTOSO Word document Open the tool pane to configure this Web Part.
DENVER
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Excel Online

Excel Online Garth Fort
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Hally Franklin 7

@3 PowerPoint Online | Holy Frankin Novtiriind pressmation E Bt Fre e T ©

FILE HOME INSERT DESIGN TRANSITIONS ANIMATIONS VIEW Tell me what you want to do -4 OPEN IN POWERPOINT
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A SHARED VISION.
A STRONG PARTNERSHIP.

Katie Jordan| January 2014

Exclusive Partner Agreement Analysis



External Sharing

) SHARE Yy Foow [
CONTOSO Contoso Partner Portal Facilities News Resources  ~ Search

Search this site

Welcome to the Contoso Partner Portal!

As amember of our partner program, you have access to a plethara of content that will empower you and our customers. This is the place for training materials, forms for facilities requests, answers to frequently asked questions, and other important reference materials.

Message from the President

Having preferred vendors and resellers like you keeps the Contoso brand name going strong. We value your every efforts and
recognize the difference you make in getting our products out into the market.
infermation that will help you keep doing what you do best. Thanks again form  Share 'Contoso Partner Portal' x

Sincerely, 2% Shared with (] Zrinka Makovac, (| Tony Krijnen, [ Sara Davis, and 22

Bonnie Keamey more
VP, Contoso Partners

Invite people
pecp Enter names, email addresses, or "Everyone',
Shared with
Top Partner News

Got Questions About Our Latest Products? Include a personal message with this

Visit our FAQs site in the Resources area for answers to common product-related questions. invitation (Optional).

03/39/2013

New Badge Request Process Available
1 For those looking to get their badging requests handled quickly, there is a new online proce! Document Center
= OPTIONS

02/28/2013

T Schedule Your Preduct Training Now Sh
ﬁ To supplement the materials you can download from the Document Center, you can now sch

our Resources area.




DOCUMENT
CONVERSATIONS

ﬂ; PowerPoint Online | Holy Frankiin Northwind presentation Garth Fort

Yammer Conversations

Click to see 1 new message

FILE EDIT PRESENTATION ~ SHARE START SLIDE SHOW COMMENTS

Garth Fort

To All Company

Holly - this looks great! Made some adjustments
to slide 5 for you

Northwind presentation.

microsoftofficedemosd
-my.sharepoint.com

Like - Reply -

Bonnie Kearney
Agreed! Holly, do you mind if | steal a few slides for

a presentation I'm building for WingTip Toys?

A SHARED VISION.
A STRONG PARTNERSHIP. g

v Conversation - 5 minutes ago

lie Jordan| January 2014

Exclusive Partner Agreement Analysis




Office 365 Video

Home Channels .

Windows Translator Kinect in Surgery
013 . 017

I Popular  See all videos

Merdom - X 4 bows

- 2} thomas Kemper Soda Company Team Ste
Big Business Tools at a Small Busi... ~ SharePoint Online Most Important Marketing«@#Portunity Celebrating Heroic Women Connecting With Videos
015 - 0 . 004
Team Site
A picture s wortha thousagd
he
Office 365 Video Intro Shared Docs in Office 365 Future of Productivity Customer Referral Business Methodology
045 e 05 e 008 s 009 we 021

I Executive Corner  See all videos
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MOBILE BROWSING

HOME -_—_— OneDrive - Contoso
COMMUNITIES files recent shared with me fc
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A EMPLOYEE » Community Service oo
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NEWS Shared with Everyone eee
& RESOURCES
2
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PEOPLE EXPERIENCES

Office 365

£ search Search

You can easily find colleagues to learn more
A Home about them and what they're working on.
f Type your name now to see your own page.
Bl ve )

BOARDS

v
W Marketing Campaigns I‘ l
|
ot

2 )
W Sales Performance kit Wi

Activity  Profile

20f2

WEB MARKETING MANAGER, Sales & Ma

v

W Message Ll S Email

PEOPLE

ﬁ Janet Schorr @ Edit Profile

About me Organization

I have been a web marketing manager at Contoso for the last seven years. My background is in marketing and sales, and | ‘ Anne Wallace
am currently working on campaigns for the XT series of products.

oMy President

Bonnie Kearney
Sr. VP Sales & Marketing

Zrinka Makovac
VP Marketing

Contact

M Message GarthF@online3.onmicrosoft.com Garth Fort

$  call +19185550101 Web Marketing Manager, Sales & Marketing
S Email GarthF@online3.onmicrosoft.com

B office 20/1101

Blog

W A Posts
@ Start Writing

Past projects

& Contoso Web Marketing Portal, Web Marketing Plan 2012,Metrics for Web Marketing Effectiveness

About privacy in Delve Skills



AUDITING

Office 365

) sHARE ¥y FoLLOw [T

Search this site - 0

View Auditing Reports o

ntent Activity Reports

B Content viewing
This report shows all events where a user viewed content in this site.

8] Content medifications
This report shows all events that modified content in this site.

8] Deletion
This report shows all events that caused content in this site to be deleted or restored from the Recycle Bin.

B Content type and list modifications
This report shows all events that modified content types and lists in this site.

= Information Management Policy Reports

B3 Policy modifications

This report shows all events related to the creation and use of information management policies on content in this site.
B Expiration and Disposition

This report shows all events related to the expiration and disposition of content in this site,
= Security And Site Settings Reports

B9 Auditing settings
This report shows all events that change the auditing settings of Microsoft SharePoint Foundation.

B Security settings

This report shows all events that change the security configuration of Microsoft SharePoint Foundation.

= Custom Reports

B9 Run a custom report
Manually specify the filters for your Audit Report.



COMPLIANCE

Office 365 Admin

Compliance Center

Home Welcome

Archiving The Office 365 Compliance Center contains the key features for an Office 365 admin to manage compliance across Office 365.

Need Help?

avery Read our docs
How do |l ... Get support
Retention Visit the Office 365 Community
Import Manage parmissions for the Compliance Center?

Permissions . .
Secure and manage the mobile devices that connect to my organization?

Control which content in my organization should be retained?

rovide additional storage for my users?

Were you looking for tifstandards that Office 365 complies with? Read about them in the Office 365 Trust Center.




DOCUMENT POLICIES

BROWSE  PAGE ) sHARE ¥y FoLLOw [T

Search this site v 0O
> Document Deletion Policy Center

Deletion Policies Use the Document Deletion Policy Center to manage policies that can delete documents after a specified period of time. These policies can then be assigned to specific site collections or to site collection templates. Learn more about Document Deletion Policies...

Policy Assignments for

Templates

Policy Assignments for Site Deletion Policies . - ; . . - . . . . . - . . .

Collections Create and manage deletion policies that can delete documents after a specified period of time. These policies can then be assigned to site collections or site collection templates. Policies that include a default rule will be automatically
Q applied without any site administration selection required.

Name Modified
Sample MySite Policy A few seconds ago

Sample Document Policy A few seconds ago

Poli ssignments for Templates
Assi eletion policies to site collection templates. All site collections created from the template will use these policies, unless there's a policy assigned to a specific site collection to override these.

Modified

here are no items to show in this view of the “Policy Assignments” list.

Policy Assignments for Site Collections
Assign deletion palicies to specific site collections. These assignments will override any policies assigned to the site collection template

Name  Modified

There are no items to show in this view of the "Policy Assignments” list.
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